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SYSTEM REQUIREMENTS  Version 5.8.2  

The following requirements are for Perspective operating in a traditional LAN/WAN environment with the Web server 
component running on a separate Microsoft IIS box. These specs are for planning purposes only and apply to Perspective™ 
V.5.8.2, Dispatch, and Connect. Please contact your Resolver representative for a specific assessment of your needs.  
 
NOTE: Meeting the Minimum system requirements means you can run the application successfully, but it may not provide the 
best performance. Meeting the Recommended requirements will offer a significantly better experience.  

 

MINIMUM RECOMMENDED 
CLIENT MACHINE 

Processor Speed 2 GHz dual-core 2.5 GHz dual-core 

Memory  2 GB 4 GB 

Operating System  Windows 8.1, Windows 10 

.NET Framework  Version 4.7.2 

Web Browser – Launch 
Perspective 

Internet Explorer 11, Edge 

Web Browser – Web 
Portal Internet Explorer 11, Edge, Google Chrome, Safari iOS 9+, Android Browser 4.2+ 

Web Browser – Connect Google Chrome 

Third Party Application Adobe Reader 9.4.0+, Sun Java Runtime Environment 7 U71, 8 U251 

Mobile iOS App  iOS 10, iOS 11 

Officer Mobile iOS 10 or newer, Android 8.0 or newer 

Resolution 1280x720, 1792 x 1344, 1920x1080, 1920x1440, 2560x1600, or 2736x1824. DPI 100%, 125%, 
200%, or 225%. 

WEB SERVER MACHINE2  (ON PREMISE ONLY) 

Available Disk Space3 1 GB 2 GB 

Processor Speed  2 GHz dual-core 2.5 GHz quad-core 

Memory  8 GB 16 GB 

Operating System  
Windows Server 2012, Windows Server 2012 R24, Windows Server 2016, Windows Server 2019, 

IIS with WebSockets enabled5 and Secure-Channel configured (HTTPS/SSL) 

.NET Framework  
Version 4.7.2 with HTTP and non-HTTP activation,  

.NET Core 1.0.4 or 1.1.1 (Windows Hosting)4 

C++ Runtime Libraries C++ 2010 SP1 Runtime Libraries (x64) 10.40219 

Message Queue – 
Connect4/Dispatch5 
service clustering 

RabbitMQ Server 3.7.7+ 
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Inbound Ports6 443 

Outbound Ports6 443, 2195, 2196, 5223, 5228, 5672 

DATABASE SERVER MACHINE2  (ON PREMISE ONLY) 

Available Disk Space  2 GB 20+ GB 

Processor Speed  2 GHz dual-core 64-bit server dual-core or multi-processors 

Memory  2 GB 4+ GB 

Database Server7 SQL Server 2012 SP3, SQL Server 2014 SP2, SQL Server 2016 SP1, SQL Server 2017 

Reporting Services 
SQL Server 2012 Reporting Services, SQL Server 2014 Reporting Services, SQL Server 2016 

Reporting Services, SQL Server 2017 Reporting Services 

 
1. This requirement only applies if you’re using Visual Analysis. 

2. These requirements apply to systems with up to 25 users. For systems with 25+ users, contact your Resolver account 
manager for more information.  

3. Depending on the size of the Perspective database, more disk space may be needed for Workflow.  

4. This requirement only applies if you’re using Connect. 

5. This requirement only applies if you’re using Dispatch. 

6. For more information on these requirements, see the Inbound & Outbound Ports article. 

7. Only SQL Server Enterprise Edition is supported for indexing on audit tables. 

Notes:  

• Internet connectivity on the client machine is required for full functionality. 

• The Perspective client is deployed as a ClickOnce application, launched from IE. It has a zero-client footprint and 
doesn’t require administrative rights to launch. 

• If single sign-on authentication or add from Active Directory is used, Active Directory Services must be enabled on 
the Perspective Web Server. 

• Net.TCP binding on port 808 is required only if using DispatchLog. 

• For the best Dispatch experience, it’s recommended that dispatchers run the application on two monitors with a 
resolution of 1920x1080. 

• Time synchronization is required for Dispatch visual alerts. NTP is strongly recommended for Hosted customers. 

• For the best performance, do not run the Indexer on the same server where the database is hosted.  

https://support.resolver.com/hc/en-ca/articles/360000353626-Inbound-Outbound-Port-Requirements
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Inbound & Outbound Ports 
The following ports may be required, depending on the additional components you have installed or will 

be installing. 

Inbound 
 

Port 443 is required for inbound connections to Integration Services. 

Outbound 
 

• Perspective/Dispatch:  

 

o dev.virtualearth.net:443 for Bing Maps. 

 

o dc.services.visualstudio.com:443 and dc.applicationinsights.microsoft.com:443. These 

ports are required only if Application Insights event logging is through Microsoft Azure. 

 

• Connect: <RabbitMQ hostname>:5672. This port is required only if you’re running a Connect 

integration with Integration Services 5.8.2 and up and a firewall exists between Integration 

Services and the configured RabbitMQ server. 

 

• Officer Mobile: dc.services.visualstudio.com:443 and dc.applicationinsights.microsoft.com:443. 

These ports are required only if Integration Services has been configured to send logs and 

telemetry to Application insights. 

 

o Officer Mobile (iOS): All IP addresses on the entire 17.0.0.0/8 address block require 

2195, 2196, and 5223 for Apple Push Notification Services. 

 

o Officer Mobile (Android): android.googleapis.com:443 and mtalk.google.com:5228 for 

Google Cloud Messaging. 

 

• Other Integration Services clustered instances: <Other IS instance hostname>: 443. This port is 

required only if service clustering is enabled and a firewall exists between instances. 
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Standard Install 

SQL Database Server 

1. Ensure Microsoft SQL Server 2012 SP3 or better has been installed. 

2. Install the Perspective database:  

a. Launch Microsoft SQL Server Management Studio. 

b. Right-click databases and select Restore Database.  

c. Under From Device, click the Browse (...) button and browse to the appropriate database: 

default, sample, or system. 

Note: Standard backups are found in Perspective Install > Database Setup > New. If you're 

unsure which database to use, contact your Perspective Administrator. 

d. Click OK. 

e. Check the Restore option. 

f. Enter a database name in To Database, and then click OK. The database should now appear in 

the database list. 

3. Create a new SQL user that will be used by Perspective to connect to the SQL Server: 

a. Launch Microsoft SQL Server Management Studio. In the menu on your left, expand the 

Security node, right-click Logins, and select New Login. 
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b. In the Login – New form, under the General page, type in the Login Name and modify the rest 

of the options according to your preference. 

c. Open User Mapping. Ensure the account has db_owner role membership rights, then click OK. 
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SQL Reporting Services 

1. Ensure that SQL Server Reporting Services is installed. 

2. From the Perspective install directory, copy the Reports Setup folder and all subfolders to a 

temporary directory on the Reporting Services computer. 

3. Edit the PublishServerReports.bat file in the temporary directory. Before making any changes, save 

a backup copy of the original PublishServerReports.bat file. 

• Edit databaseServerName to <Name_of_Database_Server>. 

• Edit databaseName to <Name_of_Database>. 

• Edit databaseUserId to <sql_User_Account>. 

• Edit databasePassword to <sqlUser_Password>. 

4. Save changes and run the PublishServerReports.bat file to publish reports to the Report Manager. 

If the file fails to run, see Troubleshooting Tips.  

5. Browse to your Reporting Services Web site (e.g. https://localhost/Reports/). 

a. On the Contents tab, click the Perspective folder. 

b. Click Properties, Security and New Role Assignment, then Edit Item Security. 

 

c. Enter a Windows Service Account for the Perspective application to use when connecting to 

Reporting Services. Create a new local user, if you do not have one already. Ensure that the 

password is not set to expire. 
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d. Select the Browser role and click OK. 

 

Perspective Services (Application Web Server) 

Completing the following steps will install Perspective Services, Integration Services, Real Time Services, 

and Web Portal.  

 

 

 

 

  Enable IIS 6 Metabase Compatibility (image is taken from Windows Server 2012). 
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  Ensure Internet Information Services (IIS) is installed and that IIS has WCF Activation 

turned on and, if installing an edition of Perspective with Dispatch, ensure the WebSocket 

Protocol is installed (image is taken from Windows Server 2012). 

 

1. From the Perspective Install > Web Service Setup directory, run as an administrator 

Perspective.Services.exe. To complete the setup, follow the wizard's guidelines. 

a. If the User Account Control screen pop-up window appears, click Yes. 
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b. Wait for the Perspective Service Setup Wizard to start. Click Next. 

c. Read the License Agreement. If you accept the terms and conditions, select the appropriate 

radio button, and click Next. 

d. The default install path for the Complete install is C:/inetpub/wwwroot/Perspective5.8.2. Ensure 

Complete is selected, then click Next. 

e. In the following screen, click Install to confirm the installation. Wait while Perspective Services 

is being installed. 

f. If Visual C++ 2010 SP1 Runtime Libraries (x64) is not installed, you will be prompted to install 

the Runtime Libraries. If already installed, skip to step 2i. 

 

g. Accept the Terms and Agreements, and click Install. 

h. When the installation is complete, click Finish.  

i. Perspective Services installation will continue. 

j. Click Finish once the installation is complete. 
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Only check the Show the Windows Installer log box if you want to see where the files have 

been installed. 

Set Up Secure Sockets Layer (SSL) on Internet Information Services (IIS) 

To set up SSL on IIS, follow the instructions on the Microsoft IIS website. 

Configure Connections Using Service Manager 

1. From the Perspective Install > Web Service Setup directory, run Perspective.ServiceManager.exe 

as an administrator. 

a. If the User Account Control screen pop-up window appears, click Yes. 

2. The installation wizard appears. Click Next to continue. 

a. Read the License Agreement. If you accept the terms and conditions, select the appropriate 

radio button and click Next. 

b. You can change the installation directory, or click Next for default file path 

c. In the following screen, click Install to confirm the installation. Wait while Perspective Service 

Manager is being installed. 

d. Click Finish once the installation is complete. 

• Only check the Show the Windows Installer log box if you want to see where the files 

have been installed. 

3. From the Start menu, or desktop, launch Perspective 5.8.2 Service Manager as an Administrator.  

Note: This process may trigger Windows' UAC (User Access Control) security feature. If prompted, 

click Yes. 

http://www.iis.net/learn/manage/configuring-security/how-to-set-up-ssl-on-iis
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If you changed the installation path, you may be prompted to select a Perspective configuration file. 

Navigate to the installed location of Perspective Services, select 

Perspective_[Your_Business_ID].config (default location: 

C:\inetpub\wwwroot\Perspective5.8.2\PerspectiveServices) and open the configuration file.  

Note: If you’re using Perspective On Premise and your organization’s business ID is Default, the 

configuration file will be saved as Perspective_Default.config. 

You’ll be prompted for database information. 
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4. Enter a new name for Connection ID.  

Note: The Connection ID cannot contain the word “Default”. 

5. In the SQL Server lookup list, select your SQL Server or type the name of your server in the text 

box. 

6. Leave Default Language ID set to 0, unless instructed otherwise by Resolver. 

7. Ensure SQL Authentication is selected, and enter the SQL Username and Password created when 

installing the database. 

8. Select your Perspective database from the Databases lookup list. 

Note: If you receive an “Unable to connect to the named server” message, you have entered either 

the wrong SQL server name or credentials. 

9. Click OK to save and add the primary connection. 

10. In the top field, enter your Company Name, as listed on the email provided to you with your license 

keys. 
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11. Enter the Master Key that applies to the Company Name entered. Note, the Master Key is case-

sensitive. 

12. Click the Validate button. The fields below will indicate the number of active licenses, License 

Expiry Date, Product Level and specifications of individual Licensed Modules (i.e., Product, 

Number of Users and Expiry Date). 

Note: The Allow connections to Perspective License Service box is checked by default. 

Unchecking this box means a license file must be imported when you click the Validate button. If 

you don’t have a license file, contact Technical Support at 1-877-776-2995.  

  

13. Open the Database component from the menu on the left and double-click your database name, or 

click the Edit button.  
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14. Open the Report Service tab and type the report server URL in the Report Server URL box. 

15. Enter the name of your Reports Folder. 

16. Proceed to the Report Service User section below. Enter the Domain, Username and Password 

that were granted browser rights when setting up the server-side reports. 

17. Click the Test button. You should receive a prompt telling you the URL is valid. If not, confirm your 

configuration is correct and try again.  Please refer to troubleshooting section for SQL reports if you 

receive an error and message.   

18. Click OK. 

  

19. Select the Configuration component from the Perspective Service Manager menu. 

20. To encrypt the Perspective_Default.config file, check the Encrypt Configuration? box. 

21. Open the Client-Side Configuration tab. 
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22. Enter the Download URL for Client-Side Reports, if needed, for the client reports configuration 

files to update automatically (i.e., https://<servername>/perspectiveservices/client). 

  

23. Click Save. 

Note: If you do not click Save, you will be prompted to save all changes that have been made. 

24. Close the Service Manager by clicking the Cancel button, or clicking the X button on the caption bar. 

25. Restart IIS. 

  Advanced Configurations Warning 

Additional options in the Service Manager are not covered in this step-by-step Standard 

Install walkthrough. For the list of supported advanced setup configuration options, 

please refer to the Advanced Configurations section. It’s recommended that all setups 

follow the standard setup procedures outlined in this section as an initial starting point. 

Advanced features can be configured as needed after the standard configuration has 

been verified to run correctly. 
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Dispatch Scheduling Service Database Restore 

This section applies to users installing an edition of Perspective with Dispatch and those who wish to use 

the scheduled dispatch feature. If you’re not installing Dispatch or you won’t be using the scheduled 

dispatch feature, skip this section. 

1. Open SQL Management Studio. 
 

2. Right-click Object Explorer and click Restore Database. 
 

 
 

3. Navigate to the location of Dispatching Schedule Service database backup file.  
  
Note: Standard backups are found in Perspective Install > Database Setup > New. If you're unsure 
which database to use, contact your Perspective Administrator. 
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4. Click OK to restore 
 

5. Create a new SQL user that will be used by Perspective to connect to the SQL Server: 

a. Launch Microsoft SQL Server Management Studio. In the menu on your left, expand the Security 

node, right-click Logins, and select New Login. 
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b. In the Login – New form, under the General page, type in the Login Name and modify the rest 

of the options according to your preference. 

c. Open User Mapping. Ensure the account has either db_owner OR db_datareader and 

db_datawriter role membership rights, then click OK. 

 

6. Complete the steps in the Dispatch Scheduling Services section below. 
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Dispatch Scheduling Services 

This section applies to users installing an edition of Perspective with Dispatch and those who wish to use 

the scheduled dispatch feature. If you’re not installing Dispatch or you won’t be using the scheduled 

dispatch feature, skip this section. 

1. Navigate to install location of the scheduling service. If you completed a default installation of 

Perspective Services, it’s located at C:\Program Files\Resolver Inc\Perspective\5.8.2\Dispatch 

Scheduling Service. If you completed a custom installation, this location is the path that was 

specified in the InstallShield Wizard. 

 

  
 

2. Open the Connections.xml file. 
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3. Select, copy, then paste the following tags below the <ArrayOfConnectionInfo> tag: 

<ConnectionInfo> 

    <ServiceFolder></ServiceFolder> 

    <Ssl></Ssl> 

    <UserId></UserId> 

    <Password></Password> 

    <BusinessId></BusinessId> 

    <DatabaseId>/DatabaseId> 

  </ConnectionInfo> 

</ArrayOfConnectionInfo> 

 

4. Enter the required information between the following tags: 
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• ServiceFolder: Enter the service folder information to show the Integration Services virtual 

directory (e.g. <servername>/integrationservices). 

Note: If Scheduling Services and Integration Services are installed on the same machine, the 

Service Folder element(s) in the Connections.xml file must contain either an IPv4 address or the 

localhost alias. 

• SSL: Enter true to enable SSL (required). 

• UserID: Enter the username of the ScheduledService Dispatch user who will be triggering the 

scheduled dispatch. 

• Password: Enter the service user’s password. Once the service begins running, the password 

will be encrypted and the <Password> tags will be converted to <EncryptedPassword>. 

Note: For security reasons, it’s recommended the service user changes their password in 

Perspective prior to starting the scheduling service. Ensure the password entered in the 

<Password> tags match the Perspective password. 

• BusinessId: Enter your organization’s Perspective business ID. 

• DatabaseID: Enter your Perspective database name. 

5. Save your changes to the Connections.xml file, then close. 

 

6. Open the SchedulingServices.exe.config file. 

 

7. Under appSettings. enter the database connection string to point to the Scheduling Service 

database. For example:  

 

<add key="DataBaseConnectionString" value="Data Source==<dbserver\dbinstance>;Initial 

Catalog=<dbname>;user id=<user>;password=<password>;Application Name=Integration 

Services" /> 

 

8. Save your changes to the SchedulingServices.exe.config file then close. 

 

9. Open Windows Services. 
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10. Click on Dispatching Schedule Service. 

 

11. Click the  icon or right-click Dispatching Schedule Service then click Start. 

Dispatch Service Clustering 

This section applies to users who are installing an edition of Perspective with Dispatch and wish to 

implement Dispatch service clustering. If you’re not installing Dispatch or you do not wish to use 

clustering, skip this section. 

1. Ensure RabbitMQ 3.7.7 or later is installed on the Perspective web server or a separate web server. 

2. Navigate to the install directory of Integration Services. By default, the directory is located at 

C:\inetpub\wwwroot\Perspective5.8.2\IntegrationServices. 

3. Open the web.config file. 

4. In the <appSettings> tags, make changes as needed to the following settings for the deployed web 

server: 

https://www.rabbitmq.com/download.html
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• PerspectiveConfigFilePath: The physical path where Perspective Services is deployed. 

• ServiceClusters: Enter true or false to enable or disable service clustering for Dispatch. 

• ClusterProcessID: Enter a number, GUID, or string to identify the instance of Integration 

Services.  

5. Copy and paste the <appSettings> section and complete the required fields for each instance of 

Integration Services. 

Note: Each instance must be assigned a unique number in the <ClusterProcessID> tags. 

6. Save your changes in the web.config file, then close it. 

7. Open the Perspective_default.config file. By default, it can be found at 

C:\inetpub\wwwroot\Perspective5.8.2\PerspectiveServices. 

8. In the <ClusterQueueConfiguration> tags, enter the following information: 

• HostName: The RabbitMQ hostname. 

• VirtualHost: The name of the RabbitMQ virtual host that will be used for clustering. 

• User: The username of the RabbitMQ user with CRUD access to the virtual host. 

• Password: The RabbitMQ user’s password. 

• NetworkRecoveryIntervalInSeconds: The number of seconds between each network 

recovery interval. 

• RequestHeartbeatIntervalInSeconds: The number of seconds between each heartbeat 

interval. 

9. Save your changes in the Perspective_Default.config file, then close it. 
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Connect Device Manager Configurations 

This section applies to users installing an edition of Perspective with the Dispatch application, along with 

Connect 1.1. If you’re not installing an edition of Perspective with Dispatch and Connect, skip this 

section. 

To view the Connect devices in Dispatch, the Device Manager URL in the Perspective_default.config file 

must be edited to show the Connect server. Note that Perspective should only use an instance of 

Connect as its Device Manager if the Connect instance is using Perspective’s instance of Integration 

Services for authentication. 

Note: To successfully configure the Device Manager, the Perspective_default.config file cannot be 

encrypted through Service Manager. 

1. Using Notepad, open the Perspective_default.config file. By default, it can be found at 

C:\inetpub\wwwroot\Perspective5.8.2\PerspectiveServices. 

2. Scroll down to the bottom of the file and locate the <DeviceManagerURL> tags. 

3. Change the URL in the tags to point to the Connect server. 

 

Note: Only one Device Manager URL is permitted per config file. 

4. If you’re using the Alarms feature in Connect and Dispatch, enter the following tags below the 

<DeviceManagerURL> tag, entering the RabbitMQ server information within the tags as required 

(this information can be obtained from your RabbitMQ administrator): 

<ConnectQueueConfiguration> 

  <HostName>...</HostName> 

  <VirtualHost>...</VirtualHost> 

  <UserName>...</UserName> 

  <Password>...</Password> 
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  <NetworkRecoveryIntervalInSeconds>...</NetworkRecoveryIntervalInSeconds> 

</ConnectQueueConfiguration> 

5. Click File > Save to save your changes, then close the file. 

Real Time Service Configuration (DispatchLog) 

If you’re installing a version of Perspective that includes DispatchLog, additional configuration to Real 

Time Services is required. 

1. Navigate to your IIS Settings. 

2. Expand Site and expand Default Web Site. 

3. Right-click PerspectiveRealTime then Manage Application >Advanced Settings.  

4. In Advanced Settings, add http,net.tcp in Enabled Protocols. Click OK. 

Note: Port 808 is used by default. 

 

5. Go to the inetpub/wwwroot/Perspective5.8.2/PerspectiveServices directory and edit the 

Perspective Default Config file. To do this, find the Perspective Real Time URL, and replace the 

localhost with a fully qualified server name. 
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Note: Additional exceptions for Windows and network firewall may be required.  

Client Machines 

Accessing Perspective Desktop Client 

1. Ensure Microsoft .NET 4.7.1 Framework is installed on the client machine. 

2. Browse to the Perspective Services URL:  

• https://<servername>/PerspectiveServices <servername> refers to the Perspective Web 

server installed in the previous section. 

a. Click the Perspective icon. 

 

b. Click Run. 

c. If you’re using the MSI Package installer, follow the procedures below. 

i. Browse to the Perspective Services URL (e.g. 

https://<servername>/PerspectiveServices/?opt=0)  

• If you’re using ?opt=1, only the ClickOnce installer will be displayed.  

• If you’re using ?opt=0 or if Java Script is disabled or the Web Service is not a trusted 

site, both the ClickOnce and MSI Package installer will be displayed. 
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ii. Download the MSI Package and follow the on-screen instructions. If you experience any 

problems during the download of the MSI Package or the installation of the MSI client, call 

Technical Support at 1-877-776-2995 for assistance. 

Note: Following the configuration of the Web Server, please ensure application initialization has 

taken place so that end users do not experience delays with initial page loading. After any IIS 

reset or configuration, navigate to https://<servername>/IntegrationServices/service.svc to 

begin the application initialization. 

3. After Perspective downloads and installs, you might be prompted to enter a URL. The URL should 

be automatically populated.If so, move to the next step. If not, enter your Perspective Services URL 

as before: https://<servername>/PerspectiveServices. <servername> refers to the Perspective 

Web server installed during the installation of Perspective. 

Now you should be able to test the default Perspective logon. From this point onward, users must 

navigate to the Perspective Services URL to launch the Perspective application. 

 

To create a shortcut to the application on the client machine’s desktop, proceed as follows: 

1. Navigate to the Perspective Services URL.  

2. Right-click the Launch Perspective button and select Copy Shortcut. 

3. Right-click the client desktop and select Paste Shortcut. 

Perspective Default Logon 

User Name:  Admin 

Password:  Security 
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  Default Admin Master vs. Users with Administrator Rights 

As of Perspective Version 3.3, there are differences between the default Admin 

Master account and a Perspective User with Administrator rights. Specifically, the 

Admin Master has select features available that other Users, even with Administrator 

rights, do not. 

However, the default Admin Master can only access the Administration and 

Dashboard panels of Perspective. Other components are unavailable to the Admin 

Master; this account cannot be used for data entry. 

Accessing Perspective Web Portal 

Users can’t access the Web Portal until an administrator has set up workgroups within Perspective that 

allow imports. Once the workgroups are set up, the Web Portal can be configured. 

To configure your Web Portal: 

1. Open an Internet browser (either Google Chrome or Internet Explorer 11 or greater). 

2. Click Portal on the launch page or navigate to your Portal Services URL: 

https://<servername>/PerspectivePortal. <servername> refers to the web server installed during 

the installation of Portal. 

3. Administrators will be required to log in to set up the Web Portal. Refer to the Perspective Web 

Portal User Guide for additional information.
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Testing Perspective Implementation 

Once you have completed the steps outlined on the previous sections, please go through the following 

steps to ensure that all Perspective’s components have been set up properly. 

Note: Following the configuration of the Web Server, please ensure application initialization has taken 

place so that end users do not experience delays with initial page loading. After any IIS reset or 

configuration, navigate to https://<servername>/IntegrationServices/service.svc to begin the application 

initialization. 

1. Go to the Perspective Services URL and confirm that the page loads properly: 
https://<localhost>/perspectiveservices, where <localhost> is the appropriate local host address 
on your network. 

2. Go to the Perspective Services page and confirm that the page loads properly: 
https://<localhost>/perspectiveservices/service.asmx, where <localhost> is the appropriate local 
host address on your network. 

3. Go to the Report Manager page and confirm that the page loads properly: 
http://<reportservername>/reports, where <reportservername> is the appropriate address for the 
reports server on your network. 

Note: If your Report Manager page does not display correctly, run the PublishServerReports.bat file 
included in the Perspective Install > Reports Setup folder. 

 

4. Log on to the Perspective client—preferably not on the server itself—using your Perspective 
administrator user name and password. 

5. Once you have logged on successfully, click on the Reports button in the Navigation pane (on the 
left-hand side of the screen) and confirm that all reports are listed. The easiest way to confirm that 
the client-side reports are working is to verify that there are reports listed under the Detail Reports 
heading, such as the Incident, Person and Vehicle Reports.  

6. To also confirm you are connected to the correct database, run the Workgroup List report and 
verify the workgroups listed. 
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7. To confirm that the server-side reports are working, try running the Test Report under the 

<Administrative Only> node listed. If you receive an error message, see the Troubleshooting 

Perspective & SQL Reporting Services article on the Resolver Support site for more information. 

Note: Both the Report version and database version should display as 5.8.2.

https://support.resolver.com/hc/en-ca/articles/208662796-Troubleshooting-Perspective-SQL-Reporting-Services
https://support.resolver.com/hc/en-ca/articles/208662796-Troubleshooting-Perspective-SQL-Reporting-Services
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Advanced Configurations 
Perspective offers your organization a number of advanced configuration options. Before attempting to 

implement any of the following options, we recommend that you complete the standard installation first, 

then contact Technical Support at 1-877-776-2995 or support@resolver.com for further instructions.   

SSL on Your Web Service 
To secure and encrypt data sent to and from the Web service to 

client machines. 

Windows Authentication 
To allow users to log on to Perspective and to connect to SQL 

service using their Windows authenticated account 

IIS Compression 

To compress information sent from Web services to the client. 

(Recommended for installs with remote users who are not connected 

directly to the network. If all users are internal, compressing data 

may take longer than sending uncompressed data over a high-speed 

network.) 

Transparent Data 

Encryption 

For encrypting data at rest (for use with Microsoft SQL Server 

Enterprise Edition only). 

Setting up Sample/Training 

Database 

Default setup supports one database only. If additional databases 

are required, these can be set up with assistance from Technical 

Support. 

AE Mirroring 
For sites with high volumes of data that require SQL intensive 

searches to be executed against a separate SQL server. 

Custom Pagination 

By default, the pagination feature is set to 100 records per page. 

This number can be modified (to any value from 20 to 1000 records 

per page) by manually editing the 

<PaginationPageSize>100</PaginationPageSize> tag in the 

Perspective_Default.config file. 

mailto:support@resolver.com
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Custom Legal Notice and 

Privacy Statement 

To customize Perspective’s legal notice and/or privacy statement for 

your organization, navigate to the Legal folder in the Perspective 

Services Virtual Directory, open the LegalNotice.mht or 

PrivacyStatement.mht file in an HTML editor (such as Microsoft 

Word), apply your edits, and save the file as an MHTML document 

with the original file name. 

Change Default Install 

Location 

To change the default installation location, select Custom from the 

Setup Type screen (when installing Perspective Services). Click Next. 

Select a feature and click the Change button. Then, pick the new 

install location. Click Ok. 

Change Caching Options of 

Portal 

The caching duration is set by default to 20 minutes. However, this 

can be changed by accessing the web config file of Perspective 

Portal. The duration is in minutes, and can be between 1-1400 

minutes.  

Note: Caching should always be enabled unless you are 

troubleshooting. Disable it by setting caching=false. 

Directing to Fully Qualified 

Servers for Portal 

Go to C:/inetpub/wwwroot/Perspective5.8.2/PerspectivePortal and 

edit the web config file. Find the external web address and update it 

to a fully qualified server. 

Application Insights 
Allows you to see logs from the application that can help with 

debugging issues. To use this feature, contact Resolver Support. 

Set Up Additional Features Using Service Manager 

Perspective Service Manager is an external application available only on the Web server hosting 

Perspective services. It is used to manage configuration files, databases, licenses and keys, as well as to 

set up a number of important features in Perspective (i.e. email and mass notifications, attachments, 

Quick Find indexing, User Defined Fields, Custom Search integration, and Integration Services URL). 



Perspective Installation Guide  Advanced Configurations 

 © Resolver Inc.   Page 33 of 78 

To access Perspective Service Manager, go to C:\Program Files\Resolver Inc 

Inc\Perspective\5.8.2\ServiceManager > Perspective.ServerManager or open it from the Startup menu.  

Remember to complete each editing action in Perspective Service Manager by clicking Save Changes. To 

implement your settings in Perspective, restart Internet Information Services (IIS) (and the Perspective 

Web server). Note that restarting IIS will affect anyone currently logged on to Perspective. Ensure that all 

users have saved their work and exited the program prior to completing this step. 

Configuring HTTP Compression for ClickOnce Packages 

Configuration: Windows Server 2012 R2 

1. Verify that Static and Dynamic Content Compression Roles are enabled (done through server 

manager). 

 

2. In IIS Manager, click on your server. 

3. Under IIS, click Compression. 

4. Verify the Enable dynamic content compression and Enable static content compression 

checkboxes are selected. 
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5. In IIS Manager, click on your server. 

6. Under IIS, click MIME Types. Here you can see all file extensions and their associated MIME Types. 

The basic MIME Types for ClickOnce deployment are:  

          .application –> application/x-ms-application  

       .manifest –> application/x-ms-manifest  

         .deploy –> application/octet-stream 

7. For the above MIME Types to be compressed, you need to edit the applicationhost.config file which 

can be found in the %windir%\system32\inetsrv\config folder.  

8. Open this file. Under the http compression tag and under dynamic types and static types, add:  

<add mimeType="application/octet-stream" enabled="true" /> 

<add mimeType="application/x-ms-application" enabled="true" /> 

<add mimeType="application/x-ms-manifest" enabled="true" /> 
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9. Run Command prompt as an Administrator and execute this command.  This command will cache 

every file instantly: 

%windir%\system32\inetsrv\appcmd.exe set config -section:system.webServer/serverRuntime -

frequentHitThreshold:1 

10. Reset IIS. 

Configuration 

Select the Configuration component from the Perspective Service Manager menu and open the 

Configuration tab. Click Browse to navigate to the Location of Server Configuration File.  

Note: This option would be used when Perspective Services has been installed in a different location 

than the default option. 
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Client-Side Configuration 

10. Select the Configuration component from the Perspective Service 

Manager menu and open the Client-Side Configuration tab. 

11. To update the configuration with a .zip file provided by the Technical 

Support, click Browse to navigate to the Location of Updated Client-

Side Reports. The field below will indicate the Version of the client-side 

reports.  

12. Click Update Reports to Server to complete the update. 

Note: This option would be used if a newer version of client-side reports is available. 
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SAML 2.0 Authentication for SSO 

The following section provides instructions on configuring Perspective Service Manager to implement 

SSO, however, prior to completing these steps, you must confirm your identity provider (IdP) supports 

SAML 2.0 through service provider initiated SSO. SSO is supported for use with the Enterprise edition 

of Perspective. 

Your IdP will also need to provide you with instructions on adding and configuring new and existing 

Perspective users directly through their service as IdP configurations will vary. 

NOTE: If you’re using AD FS to configure SAML, see the Set Up SSO with AD FS article on the Resolver 

Support site for instructions after following the steps below. 

1. Open Service Manager. 

2. Click Configuration in the pane to the left if it’s not already open. 

3. Select the Configure Service Provider checkbox. 

4. Enter your Perspective Services URL in the Perspective URL field, then click Validate.  

Note: The URL you enter in this field must exactly match what has been entered into your IdP’s 

configurations, including the case (upper-case or lower-case letters) and slash (/ or \) direction. 

5. Enter the server certificate file name in personal exchange format (.pfx) in the Certificate File Name 

field and enter a password in the Certificate Password field. For testing purposes, a sample .pfx 

file has been included in the installation package with a file name of sp.pfx and a password of 

password. This information is required so that the services (Perspective, Dispatch, Dashboard, etc.) 

can securely communicate with the identity provider. 

6. Save a copy of the certificate file to 

*PerspectiveInstallationPath*\PerspectiveServices\SAML\Certificates. This file usually has a .PFX 

extension and will also need to export the private keys.  

Note: If you chose the default certificate file, the file was saved at this location during installation. 

https://support.resolver.com/hc/en-ca/articles/215150186
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After completing the above steps, you’ll need to select how you will input the identity provider’s details. 

See the Identity Provider Configuration section for information on uploading a metadata file or metadata 

URL or see Manual Settings for instructions on inputting the data manually.  

Identity Provider Configuration 

The settings below allow you to import your IdP’s configurations directly into Service Manager via a 

metadata file or metadata URL, which is obtained from your IdP. 

1. In Service Manager, click Database in the pane to the left. 

2. Double-click a database to edit it. 

3. Click the Authentication Mode tab. 

4. Select the SAML Authentication checkbox.  

Note: If this option is unavailable, the service provider information has not been properly configured 

in steps 3 and/or 4 in the section above.  

5. Select how you want to input the identity provider information: 
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• Metadata file: This option will require that you obtain a metadata file from your IdP to 

import the SSO configurations into Service Manager. When downloading a metadata file 

from your IdP, the certificate is usually extracted and saved in your My Documents folder, 

but it must be moved to 

*PerspectiveInstallationPath*\PerspectiveServices\SAML\Certificates after it’s been 

downloaded. 

To use this option, after downloading the file, enter the name of your IdP in the Description 

field, which will appear to users with the phrase “Login with [IdP]” on the login screens, then 

click Choose File to upload the metadata file. 

 

• Metadata URL: This option will require that you obtain a metadata URL that will import the 

SSO configurations into Service Manager. After obtaining the URL, enter the name of your 

IdP in the Description field, which will appear to users with the phrase “Login with [IdP]” on 

the login screens. Enter a valid metadata URL from your IdP in the Metadata URL field, then 

click Import. The URL will import the required configurations and should be similar to the 

following: 

https://adfs.example.com/FederationMetadata/2007-06/FederationMetadata.xml 

Note: The URL you enter in the Metadata URL field must exactly match what has been 

entered into your IdP’s configurations, including the case (upper-case or lower-case letters) 

and slash (/ or \) direction. 
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6. Click OK, then save your changes. 

Manual Settings 

If you’re not importing metadata via a file or URL, you must configure your IdP’s settings manually. 

Contact your IdP for instructions on obtaining the required information. 

1. In Service Manager, click Database in the pane to the left. 

2. Double-click a database to edit it. 

3. Click the Authentication Mode tab. 

4. Select the SAML Authentication checkbox.  

Note: If this option is unavailable, the service provider information has not been properly 

configured. See the Identity Provider Configuration section above for more information. 

5. Select the Manual settings option. 

6. Complete the following fields:  

• Description: The name of your IdP, which will appear to users with the phrase “Login with 

[IdP]” on the login screens.  

• Name: The exact name of the IdP as provided by the IdP.  
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• Partner Certificate File: Used to verify the assertions have come from the IdP. This file must 

be saved to the *PerspectiveInstallationPath*\PerspectiveServices\SAML\Certificates 

folder. 

• Single Logout URL: The URL from which the IdP accepts logout requests. 

• Single Sign On Service: The URL from which the IdP accepts SSO requests. 

• Name ID Format: The username format provided to the IdP. 

• Single Sign On Service Binding: The binding used by the IdP to authenticate (usually HTTP 

Redirect). 

• Sign Authentication Request: Select this checkbox if the authentication request should be 

signed. 

• Sign Logout Request: Select this checkbox if the logout request should be signed. 

• Sign Logout Responses: Select this checkbox if the logout response should be signed. 

• Sign Assertion: Select this checkbox if the assertions should be signed. 

• Encrypt Assertions: Select this checkbox if the assertions should be encrypted. 
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7. Click OK then save your changes. 

Export Metadata  

Once you’ve completed the configurations in the previous sections, your IdP will likely require 

Perspective metadata in order to complete the SSO process. This information can be exported into a file 

using the Export Metadata tool in Service Manager. 

1. In Service Manager, click Database in the pane to the left. 

2. Double-click a database to open it. 

3. Click the Authentication Mode tab. 

4. Select the Manual Settings option.  
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5. Click Export Metadata. 

6. Navigate to the *PerspectiveInstallationPath*\PerspectiveServices\SAML\Certificates folder, or 

an alternate location you may have selected in the previous section. 

7. Select a file name and location to export the metadata.  

Note: It’s recommended that you save the metadata file in 

*PerspectiveInstallationPath*\PerspectiveServices\SAML\Metadata in the Perspective services 

installation directory.  

8. Click OK and the metadata file will be opened. Either upload a copy of this file to your IdP server or 

save a copy in the *PerspectiveInstallationPath*\PerspectiveServices\SAML\Metadata folder if 

you did not choose that location in step 6. 

Note: The URL in the <ServiceProviderBaseURL> tags in the metadata file must exactly match what has 

been entered into your IdP’s configurations and Perspective Service Manager, including the case (upper-

case or lower-case letters) and slash (/ or \) direction. 

Perspective Configurations 

Once the Service Manager and IdP configurations are complete, a Perspective administrator must enter 

each user’s SSO username (as it’s configured in the IdP’s settings) in the Corporate ID field by going to 

Administration > Users > User Details.  

 

See the Perspective Administrator’s Guide for more information on entering this information in a user’s 

profile. 

https://support.resolver.com/hc/en-ca/sections/201705483-Documentation
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Integration Services 

Integration Services should not require any additional configuration as all SAML authentication 

information should be in the Perspective configuration file. 

Email Notifications 

In Perspective, users may send email notifications containing incident or case details or report 

attachments through Simple Mail Transfer Protocol (SMTP). Otherwise, email notifications may be sent 

when new investigators are assigned to an investigation or when assignments are created, modified, or 

completed.  

To set up email notification options, select the Configuration component in the Perspective Service 

Manager menu and open the Notification tab. Alternatively, the email function can be disabled by 

selecting the Do not use mail options radio button.  

Connect to an External SMTP Server 

To use an SMTP server to send emails from Perspective, select the SMTP radio button and enter the 

appropriate information for connecting to the SMTP server: 

• Host: The domain name of the SMTP service. 

• Port: The port the SMTP service will be listening on for connections. 

• Username: A valid username to connect to the SMTP service. 

• Password: The appropriate password for the username. 

• Enable SSL: Select this option to encrypt the SMTP connection with Secure Socket Layer (SSL). 

• Reply Address: By default, the SMTP service will include the address entered in this field when 

sending emails, unless the Person who is currently logged in has an email address saved on their 

record.  
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• Force all emails from this address: Selecting this checkbox will force all emails sent from 

Perspective to use the Reply Address as a return email address, even if the currently logged in 

Person has a primary email address saved on their record. 

The email settings outlined above will be used as system defaults for every client.  

 

Uploading Attachments 

Perspective allows users to attach any file type to any data record in the application. These files are 

stored directly in the SQL database.  Attachment size is the greatest factor in determining how much 

space will be required in SQL. 
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To set up the maximum attachment size, select the Configuration component in the Perspective Service 

Manager menu and open the Attachments tab. 

Perspective can support files up to 2 GB in size (SQL’s limit for binary data types); however, due to 

restrictions you may have on the space available for your Perspective database or bandwidth in your 

network, we do include an option to decrease this 2-GB limit to a size that can be better supported in 

your environment.  

• On SQL Standard or Enterprise, this value can be set between 1 MB and 2000 MB. The default is 

set to 250 MB.  

• On SQL Express, this value can be set between 1 MB and 50 MB. The default is 10 MB. 

To change this value to an appropriate value for your organization, move the slider.  

 

Integration Services URL 

1. To enable event trigger in Integration Services, select the Configuration component from the 

Perspective Service Manager menu and open the Services tab.  

2. Enter the URL set up with the Integration Services in the Integration Services field. 
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3. To enable trigger events on create and update, check the Enable Trigger Notification box. To 

enable context-sensitive events, check the Allow Hot Key Events box. 

 

Custom Search Integration 

With Perspective’s Custom Search feature, you can integrate Perspective with Infoglide Identity 

Resolution Engine™ (IRE) to search several data sources at once. Complete the following steps to enable 

this integration. Note that you must first configure your Perspective database within the Identity 

Resolution Engine before proceeding. 

To set up the Custom Search feature, select the Configuration component from the Perspective Service 

Manager menu and open the Services tab. Check the Enable Custom Search (with Infoglide) box and 

enter the URL for the Infoglide Identity Resolution Engine in the field below. 

Note: To access the Custom Search feature, users must be granted the appropriate access rights in 

Perspective. For details on administering Custom Search access for roles and users, see “Select general 

role rights” and “Set general user rights” in the “Roles” and “Users” sections of the Perspective 

Administrator’s Guide.  

https://support.resolver.com/hc/en-ca/sections/201705483-User-Guides
https://support.resolver.com/hc/en-ca/sections/201705483-User-Guides
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MIR3 Mass Notifications (DispatchLog) 

Perspective allows users to integrate their MIR3 in Enterprise solution into Perspective to send mass 

notifications about selected activities via Perspective DispatchLog. MIR3 mass notifications are not 

available in Dispatch. 

To set up the Mass Notification feature, select the Configuration component from the Perspective 

Service Manager menu and open the Services tab. Check the Enable Mass Notification (with MIR3) box 

and enter the Mass Notification URL, Username and Password provided by MIR3 in the field below. 
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Everbridge Mass Notifications (Dispatch) 

Perspective allows users to integrate their Everbridge solution into Perspective to send mass 

notifications about selected activities via Dispatch. Everbridge mass notifications are not available in 

DispatchLog. 

For more details on the information required in step 2 below, see the appropriate Everbridge help 

documentation. 

1. Open the Perspective_default.config file. By default, it can be found at 

C:\inetpub\wwwroot\Perspective5.8.2\PerspectiveServices. 

2. Locate the <EverbridgeConnectionInfo> tags and enter the following information: 

• ManagerURI: Enter the Everbridge management URL. 

• URL: Enter the Everbridge API URL. 
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• User: The username of the Everbridge user account that will provide access to the system. 

• Password: The user’s password. 

• Org: The Everbridge org ID. 

 

3. Save the Perspective_default.config file and close.  

Analysis Expert Tools 

If you experience difficulties with the correct Analysis Expert (AE) query display, this function must be 

used to update the AE .dat file provided by Technical Support. 

1. Select the Configuration component from the Perspective Service Manager menu and open the AE 

Tools tab. 

2. Specify the SQL Server. 

3. Select either the Windows or SQL Authentication. If you selected SQL Authentication, enter the 

correct Username and Password. 

4. Choose the Database you wish to update your queries on. 

5. Specify the correct path to the AE .dat file provided by Technical Support in the File Location field. 

6. Click Update. 
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Quick Find Indexing 

With Perspective’s Quick Find tool, you can quickly search for text anywhere in the database, including 

text within attachments. This works by scanning an index file generated on the server. 

Quick Find Indexing supports the following file formats for attachments: 

.doc, docx .pdf .txt 

.docm .rtf .wpd 

.log .sms .wps 

.msg .text .xls, .xlsx 

1. To set up indexing on your database, select the Quick Find Indexing component in the Perspective 

Service Manager menu. 

2. To enable this feature, select Allow Quick Find. 
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3. Select an Index Directory to store the index files. The name of the index directory must end with 

your organization’s business ID name (e.g. C:\Temp\[BusinessIDName]) and IIS must have access to 

read this directory. 

Note: If you’re using Perspective On Premise and your organization’s business ID is Default, the 

index entry will end in Default (e.g. C:\Temp\Default). 

4. Optional: You can expect the Index file to be approximately 1/3 of your database size.  If storage on 

the local drive would be problematic, you can force the index cache to use a separate directory by 

checking Specify folder in alternate drive to store cache while indexing? and then selecting a 

directory. 

5. Optional: If you would like certain common words to be ignored when indexing (e.g., a, the, an, at, 

to, etc.), select Use noise word file? and specify the directory where your Noise.dat file exists.  

Perspective does not provide a Noise.dat file. 

6. Optional: If you would like hyphenated words to be indexed as two separate words, you can select 

Treat hyphens as spaces. 

7. Optional: If you would like the index files to ignore any numeric text, you can select Do not index 

numeric values. 

8. Expand the nodes listed under Tables and select each table you want data to be indexed from 

individually. Note that attachments are indexed separately from the main entities and can be found 

at the bottom of the list. 

9. Click Save.  
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10. As data is added, deleted, or modified in the database, the index must be kept up-to-date. You can 

perform full indexing or incremental indexing on a database by using the Perspective.Indexer.exe 

program. To do this, open a Windows command prompt and navigate to the Perspective Service 

Manager directory as follows: 
 

cd “C:\Program Files\Resolver Inc\Perspective\5.8.2\ServiceManager” 
 

11. To perform full indexing on the default database, enter the following command: 
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Perspective.Indexer.exe 

/c="C:\[PerspectiveServicesPath]\Perspective5.8.2\PerspectiveServices\Perspective_

Default.config" 

12. To perform full indexing on a specific database, add the /d switch to the command: 

 
Perspective.Indexer.exe 

/c="C:\[PerspectiveServicesPath]\Perspective5.8.2\PerspectiveServices\Perspective_

Default.config" /d=”database name” 

13. To perform incremental indexing on the default database, add the /i switch to the command:  

Perspective.Indexer.exe 

/c="C:\[PerspectiveServicesPath]\Perspective5.8.2\PerspectiveServices\Perspective_

Default.config" /i 

14. To perform incremental indexing on a specific database, use the /d and /i switches:  

Perspective.Indexer.exe 

/c="C:\[PerspectiveServicesPath]\Perspective5.8.2\PerspectiveServices\Perspective_

Default.config" /d=”database name” /i 

15. Repeat steps 10-14 for every database you want to index. 

16. There are other switches available when using Perspective.Indexer.exe. To view all of the switches 

and their functions, enter the command Perspective.Indexer.exe ? 

User Defined Fields 

Although user defined fields (UDFs) can only be created by specialized users with access to both the 

server machine and the Service Manager, they are maintained by Administrators in the same manner as 

all other fields within Perspective. Visibility and access rights to a user defined field can be controlled 

under System Privileges, Role Privileges or User Privileges. UDF labels can be modified and created for 

other languages under Form Labels. Moreover, if the UDF is a lookup field, lookup values and workgroup 

visibility for these values can be customized under Lookups. 

You may add user defined fields to the Item, Person, Organization and Vehicle forms under the General 

tab, as well as to numerous sections of the Incident and Case forms.  

Note: The Case component is only available in the Premium edition of Perspective. 
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1. To set up user defined fields for Perspective, select the User Defined Fields banner at the bottom of 

the Perspective Service Manager menu and open the General tab. 

2. From the Form lookup list, select the data form in which you would like the new user defined field 

to appear. Your options are as follows: 

• Incidents 

• Incident Items (Involved Items) 

• Incident Organizations (Involved Organizations) 

• Incident > Persons (Involved Persons) 

• Incident > Vehicles (Involved Vehicles) 

• Items 

• Organizations 

• Persons  

• Vehicles 

• Cases 

• Activities 

3. From the Section lookup list, select the specific section of the form that you would like the user 

defined field to appear in. For all forms except Incidents and Cases, the only option available is the 

General tab. For the Incidents form, you may choose the General, Investigations (Details) or Controls 

tab. For the Cases form, you may choose either the General or Controls tab. 

4. Click the Add button at the bottom of the window. An Add UDF dialog box will open. 

5. Enter the new user defined field’s name in the Field Name text box. Note that no special characters 

or spaces may be used—letters only. Then, assign the field its default System English Label. The 

System English label is what users will see on the Perspective form. 

6. Choose the field type from the Data Type lookup list. The available field type options for UDFs are 

Number (for whole numbers), Decimal Number (for numbers with up to two decimal places), Text, 

Date, Yes/No (for a checkbox field) and Lookup List. If you selected Text as the data type, you may 

also specify the maximum number of characters that can be entered in the field under Text Length. 
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7. Click Apply. The user defined field’s details will now appear under the General tab. 

 

• To edit the user defined field, click the arrow to the left of the Field Name to select the entire 

row and click the Edit button. Make changes in the Edit UDF dialog box and click Apply. 
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• To delete the user defined field, click the arrow to the left of the Field Name to select the entire 

row and click the Delete button. A Delete UDF confirmation window will open warning you of 

potential loss of data. If you choose to delete the selected UDF and click Yes, any data 

previously tracked in the UDF will be erased as well. Instead, it’s recommended that you hide or 

lock the UDF within Perspective, if you no longer wish to use it to track data. 

8. To view the user defined field with its default form location, select the Layout tab. The Top and Left 

values indicate the number of pixels that the UDF will be located from the top left corner of the User 

Defined Fields section of the form. The User Defined Fields section always appears at the bottom of 

the form. 

 

• Click and drag the UDF label to move the UDF to an alternative location on the form. The entire 

scrollable window beneath the Layout tab is representative of the User Defined Fields section 

of the form. Click Save Layout to save the chosen UDF location on the form. 

• At any time, you may click Default Layout to return the UDF to its original assigned position on 

the form. To return the UDF to its last saved location, click Previous Layout. 
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Troubleshooting Tips 

Event Viewer 

When an error occurs in your Perspective session, first check Event Viewer to see if it has been recorded 

here. 

1. Go into Windows Event Viewer.  

2. Click the Windows Logs folder. 

3. Click the Application sub-folder. Most errors that have occurred in Perspective will be logged here. 

Perspective Server 

  Ensure Perspective Services is set up 

1. Open IIS Manager, navigate to the Perspective Services Virtual Directory, and try to browse the 

Service.asmx file. 

2. If the page that is displayed reads “Service”, the install was successful. 

If you get an error code page:  

a. Check the properties of the Perspective Services Directory and ensure it is running under 

Microsoft .NET 4.0 on the ASP.NET tab. 

b. Re-install Microsoft .NET 4.0 with ISS using the following command line: 

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis.exe 

  Connect to the database using ODBC 

1. Select Control Panel > Administrative Tools > Data Sources (ODBC), and open the System DSN 

tab. 

2. Click Add to create a data source, select SQL Server. Click Finish. 
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3. Enter the name “Perspective” and select the name of your SQL Server. 

4. If your Perspective database is using SQL authentication, select the SQL server authentication 

option and enter your SQL login credentials. 

5. Click Finish, and then click Test Data Source. 

  Test the application pool 

An application pool is used to connect to the database server. To test if there is an issue with the Web 

application pool, change the account to Network Services and see if it runs.  If you are using Windows 

Authentication for your Perspective database, change the application pool to the same one used for your 

database.  Reset the application pool, and then launch Perspective and try to login. 

  Restart IIS 

Right-click your Computer icon and select Manage. Expand the Services and Applications folder and 

right-click Internet Information Services (IIS). Select All Tasks, then restart IIS and click OK. Another 

way to restart IIS is to run the command line iisreset from the Start menu. 

Database Server 

  Ensure that the database login account has been assigned DBO access rights 

1. In Enterprise Manager, select Security > Logins. 

2. Double-click the domain user account that the Perspective server uses to connect to the database 

(e.g., the test account “PerspectiveDBCon”). 

3. On the Database Access tab, select the Perspective database and ensure that dbo access is 

assigned. 

Reporting Services Server 

For assistance and information on setting up SQL Reporting Services, view the deployment guide on 

Microsoft’s Web site: http://technet.microsoft.com/en-us/library/ms159868(SQL.90).aspx 

http://technet.microsoft.com/en-us/library/ms159868(SQL.90).aspx
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  Check the version of the Microsoft .NET Framework 

If .NET Framework 3.5 is enabled on the machine, only client-side components of Reporting Services will 

be installed. If necessary, remove the .NET Framework 3.5 before installing Reporting Services, and re-

install 3.5 afterwards using the following command line: 

C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe 

  Specify path for .bat file 

1. Using the Windows Start menu’s Search function, search for the rs.exe file. 

2. Place a copy of the rs.exe file in the Perspective Install > Reports Setup folder. 

Perspective Client 

  Connect to the Web site 

Open your Web browser and enter the following URL:  

https://<servername>/PerspectiveServices/Service.asmx 

  Ensure SQL login account is configured properly 

The SQL login account (e.g., the test account “PerspectiveDBCon”) needs permissions. 

  Troubleshoot Windows authentication issues 

Note: Windows authentication is available for Perspective only and must be enabled through the 

Perspective_default.config file. If you wish to use single sign-on for all Perspective modules 

(Perspective, Dispatch, Dashboard, and/or Web Portal) you must enable SAML authentication. 

1. Open the Perspective_default.config file. By default, this file is located at 

C:\inetpub\wwwroot\Perspective5.8.2\PerspectiveServices. 

2. Confirm the value in the <WindowsAuthentication> tag is set to true. 

Note: You cannot enable both Windows authentication and SSO in the 

Perspective_default.config file by changing the <SSOAuthentication> tag’s value to true. 
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3. In IIS, open the Default Web Site and your Perspective Services site. 

4. Double-click the Authentication icon. 

5. Ensure that:  

• Windows Authentication is enabled. 

• Anonymous Authentication is disabled. 

6. Return to the previous screen and click Edit Permissions on the right-side menu. 

7. Open the Security tab, click Edit, and add appropriate Perspective Groups with View, Read, and 

Execute permissions. 

8. Reset IIS once you have completed the steps to ensure the changes take place. 

9. Test logging in with a user who is set up for Windows Authentication in Perspective. 

  Troubleshoot application download issues 

Using Command Prompt, you can remove cached data and uninstall Perspective from your machine. 

 Note: Deleting this cached data will remove all ClickOnce data from your computer. 

1. Close all running applications. This will prevent the removal of the applications from the App Cache. 

 

2. Right-click the Start/Windows icon in the bottom-right corner of your screen. 

 

3. Click Run. 

 

4. Type or paste rundll32 dfshim CleanOnlineAppCache in the the Run dialog. 

 

5. Click OK to run the command. 
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Note: Running this command will delete the contents of the 2.0 folder 

(C:\Users\UserName\AppData\Local\Apps\2.0 and will remove all ClickOnce applications from your 

computer. 

6. Browse to the Perspective Services URL. 

7. Click the Launch Perspective button to re-download the entire Perspective application. 

8. Click Run to launch the Perspective application. 

9. Log onto Perspective (see the Perspective Administrator’s Guide or Perspective User’s Guide for 

more information on logging on). If the problem persists, please contact Resolver Technical 

Support at 1-877-776-2995 for assistance. 
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Error Messages 

Error Message Explanation 

No Connection. Perspective Client error 

Solution 

• Launch the Perspective client from the Perspective server and attempt to logon. 

• Make sure the user account is a member of the IIS_WPG group on the Perspective server. 

Response is not well formed .XML. Perspective Client error 

Solution 

• May be due to a missing bracket or other formatting issue in the 

Perspective_Default.config file. 

• May also be a permissions issue. See your local Security Policy. 

Connection to the service not found/SQL 

Exception/Login failed for user. 
Perspective Server error 

Solution 

Ensure the application pool account has access to the database. The account that the 

Perspective server is using to connect to the database must be specified as the Application Pool 

identity, and requires membership in the IIS_WPG. 
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Contact Information 

Technical Support 
Toll Free:   1-877-776-2995 

Phone:    (780) 448-0616 

Email:    support@resolver.com  

Website:   https://support.resolver.com  

Resolver 

Toll Free:   1-888-776-9776 

Phone:    (780) 448-0616 

Fax:    (780) 448-0618 

Email:    information@resolver.com 

Website:   http://www.resolver.com 

 

mailto:support@resolver.com
https://support.resolver.com/
mailto:information@resolver.com
http://www.resolver.com/
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Appendix A – Indexable Fields 
Below is a complete list of the standard indexable fields that appear in Perspective and Service Manager. 

Once indexed, these fields become searchable using the Quick Find tool in Perspective. 

Note: Custom fields (also known as UDFs or user defined fields) can also be indexed so they become 

searchable and appear in Service Manager. 

Section Sub-Section(s) Field 
Activities Activities Access Level 
Activities Activities Activity Number 
Activities Activities Activity Status 
Activities Activities Address 1 
Activities Activities Address 2 
Activities Activities Call Source 
Activities Activities Code 
Activities Activities Contact Number 
Activities Activities Description 
Activities Activities Disposition 
Activities Activities  Notes 
Activities Activities Officer Status 
Activities Activities  Organization Status 
Activities Activities  Postal Code 
Activities Activities Priority 
Activities Assignments Assignment Type 
Activities Assignments Message/Task 
Activities Activity > Items  Category/Type 
Activities Activity > Items  Disposition 
Activities Activity > Items Item Name 
Activities Activity > Items Item Value 
Activities Activity > Items Linked Item 
Activities Activity > Items  Make/Model 
Activities Activity > Items  Notes 
Activities Activity > Items Organization Owned By 
Activities Activity > Items Person Owned By 
Activities Activity > Items Serial Number 
Activities Activity > Officer Responses Call Sign 
Activities Activity > Officer Responses Officer Name 
Activities Activity > Officer Responses  Officer Response Notes 
Activities Activity > Officer Responses OfficerStatus 
Activities Activity > Organization Requests Comments 
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Section Sub-Section(s) Field 
Activities Activity > Organization Requests Contact First Name 
Activities Activity > Organization Request  Contact Last Name 
Activities Activity > Organization Requests Contact Middle Initial 
Activities Activity > Organization Requests Contact Person 
Activities Activity > Organization Requests  Contact Phone 
Activities Activity > Organization Requests  Involvement Type 
Activities Activity > Organization Requests Notified Type 
Activities Activity > Organization Requests Organization 
Activities Activity > Organization Requests Organization Name 
Activities Activity > Organization Requests  Organization Number 
Activities Activity > Organization Requests  Reference Number 
Activities Activity > Organization Requests Request Assigned To Person 
Activities Activity > Organization Requests Request Notes 
Activities Activity > Organization Requests Request Type 
Activities Activity > Organization Requests Tracking Number 
Activities Activity > Organization Responses Contact Last Name 
Activities Activity > Organization Responses Contact Middle Initial 
Activities Activity > Organization Responses Contact Person 
Activities Activity > Organization Responses Contact Phone 
Activities Activity > Organization Responses  ContactFirstName 
Activities Activity > Organization Responses Involvement Type 
Activities Activity > Organization Responses Notified By Person 
Activities Activity > Organization Responses Notified Type 
Activities Activity > Organization Responses Organization 
Activities Activity > Organization Responses Organization Name 
Activities Activity > Organization Responses Organization Number 
Activities Activity > Organization Responses Organization Response Notes 
Activities Activity > Organization Responses Organization Type 
Activities Activity > Organization Responses OrganizationStatus 
Activities Activity > Organization Responses Reference Number 
Activities Activity > Organization Responses Responding Person 
Activities Activity > Organizations Comments 
Activities Activity > Organizations Contact First Name 
Activities Activity > Organizations Contact Last Name 
Activities Activity > Organizations Contact Middle Initial 
Activities Activity > Organizations  Contact Person 
Activities Activity > Organizations Contact Phone 
Activities Activity > Organizations Involvement Type 
Activities Activity > Organizations Linked Organization 
Activities Activity > Organizations Notified By 
Activities Activity > Organizations Organization Name 
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Section Sub-Section(s) Field 
Activities Activity > Organizations Organization Number 
Activities Activity > Organizations Organization Type 
Activities Activity > Organizations Organization Webpage URL 
Activities Activity > Organizations  Reference Number 
Activities Activity > Person > Clothing Clothing Type 
Activities Activity > Person > Clothing Color 
Activities Activity > Person > Clothing Description 
Activities Activity > Person Flags Severity Level 
Activities Activity > Person > Injuries Description 
Activities Activity > Person > Injuries Injury Cause 
Activities Activity > Person > Injuries Severity 
Activities Activity > Person Designation(s) 
Activities Activity > Person Employee Number 
Activities Activity > Person  Eye Color 
Activities Activity > Person First Name 
Activities Activity > Person Flag Notes 
Activities Activity > Person Gender 
Activities Activity > Person Hair Color 
Activities Activity > Person  Initial 
Activities Activity > Person Injured 
Activities Activity > Person Involvement Type 
Activities Activity > Person Last Name 
Activities Activity > Person Linked Person   
Activities Activity > Person Marital Status 
Activities Activity > Person Notes 
Activities Activity > Person  Title 
Activities Activity > Vehicles Color 
Activities Activity > Vehicles  Comments 
Activities Activity > Vehicles Disposition 
Activities Activity > Vehicles Driver Identified 
Activities Activity > Vehicles Involvement Type 
Activities Activity > Vehicles License Plate 
Activities Activity > Vehicles  Linked Vehicle 
Activities Activity > Vehicles  Make/Model 
Activities Activity > Vehicles Plate Registered In 
Activities Activity > Vehicles  Style 
Activities Activity > Vehicles Vehicle Value 
Activities Activity > Vehicles  VIN 
Activities Activity > Vehicles Year 
Activities Attachments Attachment Title 
Activities Attachments  Attachment Type 
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Section Sub-Section(s) Field 
Activities Attachments  Description 
Activities Attachments File Extension 
Activities Attachments  File Name 
Activities Call Category Call Category Name 
Activities Call Category Code 
Activities Call Category Level 1 
Activities Call Category Level 2 
Activities Call Category Level 3 
Activities Call Category Level 4 
Activities Involved Items Item Category 
Activities Involved Items  Item Name 
Activities Involved Organizations Organization Number 
Activities Involved Organizations Organization Type 
Activities Involved Persons Gender 
Activities Involved Vehicles Incident Number 
Activities Involved Vehicles Make/Model 
Activities Geo Rollups City 
Activities Geo Rollups Country 
Activities Geo Rollups Geo Rollup Name 
Activities Geo Rollups Geo Rollup Name 
Activities Geo Rollups Level4 
Activities Geo Rollups Rollup Level 
Activities Geo Rollups State/Province 
Activities Link Activities Link Type 
Activities Link Activities Linked From Activity 
Activities Link Activities Linked To Activity 
Activities Link Activities Notes 
Activities Link Activity To Incident Link Effective Date 
Activities Link Activity To Incident Link Type 
Activities Link Activity To Incident Linked From Activity 
Activities Link Activity To Incident Linked To Incident 
Activities Link Activity To Incident Notes 
Activities Site Rollups Address 1 
Activities Site Rollups Building 
Activities Site Rollups Location 
Activities Site Rollups Postal Code 
Activities Site Rollups Rollup Level 
Activities Site Rollups Site 
Activities Site Rollups Site Name 
Activities Site Rollups Site Notes 
Activities Site Rollups Site Rollup Name 
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Section Sub-Section(s) Field 
Activities Site Rollups Site Rollups 
Activities Site Rollups Threshold 
Cases Case > Assignments Assignment Type 
Cases Case > Assignments AttachmentFrom 
Cases Case > Assignments Message/Task 
Cases Investigations Incident Number 
Cases Investigations Initiated By 
Cases Case > Investigation > Evidence Log Evidence Disposition 
Cases Case > Investigation > Evidence Log Evidence Log Status 
Cases Case > Investigation > Evidence Log Evidence Name 
Cases Case > Investigation > Evidence Log Evidence Type 
Cases Case > Investigation > Evidence Log Evidence/Property From 
Cases Case > Investigation > Evidence Log Evidence/Property Tag 
Cases Case > Investigation > Evidence Log Found/Seized Location 
Cases Case > Investigation > Evidence Log Item Description 
Cases Case > Investigation > Evidence Log Notes 
Cases Case > Investigation > Evidence Log Organization Owned By 
Cases Case > Investigation > Evidence Log Owner Name Person 
Cases Case > Investigation > Evidence Log Person In Possession 
Cases Case > Investigation > Evidence Log Secured/Storage Location 
Cases Case > Investigation > Evidence Log Seized By Person 
Cases Case > Investigation > Evidence Log Seized From Person 
Cases Evidence Log > Status Comments 
Cases Evidence Log > Status Evidence Disposition 
Cases Evidence Log > Status Status 
Cases Evidence Log > Status Storage Location 
Cases Evidence Log > Status Evidence/Property Tag 
Cases Evidence Log > Status Person In Possession 
Cases Evidence Log > Status Status Changed By Person 
Cases CaseInvestigationInterviewHistory ChangedByPersonDescription 
Cases CaseInvestigationInterviewHistory Reason 
Cases Case > Investigation > Interviews  Attached Digital Interview 
Cases Case > Investigation > Interviews  Interview Conducted by 
Cases Case > Investigation > Interviews  Interview From 
Cases Case > Investigation > Interviews  Interview Type 
Cases Case > Investigation > Interviews  Location of Interview 
Cases Case > Investigation > Interviews  Plain Text 
Cases Case > Investigation > Interviews  Subject of Interview 
Cases Case > Investigation > Interviews  Subject's Involvement Type 
Cases Case > Investigation > Interviews  Witness 
Cases Case > Investigation > Interviews  Word File 
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Section Sub-Section(s) Field 
Cases Case > Investigation > Log Expense Type 
Cases Case > Investigation > Log Log Notes 
Cases Case > Investigation > Log Logs From 
Cases Case > Investigation > Log Logs From 
Cases Case > Investigation > Log Task Done By Person 
Cases Case > Investigation > Log Task Type 
Cases Case > Investigation > Summaries Author Person 
Cases Case > Investigation > Summaries Plain Text 
Cases Case > Investigation > Summaries Summary From 
Cases Case > Investigation > Summaries Summary Type 
Cases Case > Investigation > Summaries Word File 
Cases CaseInvestigationSummaryHistory ChangedByPersonDescription 
Cases CaseInvestigationSummaryHistory Reason 
Cases Case > Investigators Comments 
Cases Case > Investigators Investigator 
Cases Case > Investigators Investigator Type 
Cases CaseNarrativeHistory Reason 
Cases Narratives Word File 
Cases Case > Reviews Comments 
Cases Case > Reviews Review Type 
Cases Cases Access Level 
Cases Cases Case Category 
Cases Cases Case Description 
Cases Cases Case Name 
Cases Cases Case Number 
Cases Cases Disposition 
Cases Cases Org Rollup 
Cases Cases Status 
Cases Case > Visibility All Workgroups 
Cases Case > Visibility Owner Workgroup 
Cases Class Rollups Category 
Cases Class Rollups Class 
Cases Class Rollups Class Code 
Cases Class Rollups Class Name 
Cases Class Rollups Consequence 
Cases Class Rollups Rollup Level 
Cases Class Rollups Subcategory 
Cases Class Rollups Type 
Cases Class Rollups Class Rollup Name 
Cases Evidence Log > Status Evidence Status 
Cases Evidence Log > Status Person In Possession 
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Section Sub-Section(s) Field 
Cases Investigation > Interviews Attached Digital Interview 
Cases Investigation > Interviews Interview Conducted by 
Cases Investigation > Interviews Interview Type 
Cases Investigation > Interviews Plain Text 
Incidents Business Unit Rollups Business Unit Name 
Incidents Business Unit Rollups Business Unit Rollup Name 
Incidents Business Unit Rollups Level 1 
Incidents Business Unit Rollups Level 2 
Incidents Business Unit Rollups Level 3 
Incidents Business Unit Rollups Level 4 
Incidents Business Unit Rollups Rollup Level 
Incidents Involved Items Disposition 
Incidents Involved Items Incident Number 
Incidents Involved Items Loss Type 
Incidents Involved Organizations Incident Number 
Incidents Involved Organizations Involvement Type 
Incidents Involved Organizations Notified By 
Incidents Involved Organizations Organization Name 
Incidents Involved Persons First Name 
Incidents Involved Persons Incident Number 
Incidents Involved Persons Involvement Type 
Incidents Involved Persons Last Name 
Incidents Involved Vehicles License Plate 
Incidents Involved Vehicles Vehicle Involvement Type 
Incidents Involved Vehicles Vehicle Year 
Incidents Narratives Author 
Incidents Narratives Narrative From 
Incidents Narratives Narrative Type 
Incidents Narratives Plain Text 
Incidents Incident > Assignments Assigned By Person 
Incidents Incident > Assignments Assigned To Person 
Incidents Incident > Assignments Assignment Type 
Incidents Incident > Assignments Message/Task 
Incidents Incident > Investigation > Evidence Log Disposition 
Incidents Incident > Investigation > Evidence Log Evidence Status 
Incidents Incident > Investigation > Evidence Log Evidence/Property Name 
Incidents Incident > Investigation > Evidence Log Evidence/Property Tag 
Incidents Incident > Investigation > Evidence Log Evidence/Property Type 
Incidents Incident > Investigation > Evidence Log Incident ID 
Incidents Incident > Investigation > Evidence Log Notes 
Incidents Incident > Investigation > Evidence Log Owner Name Organization 
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Section Sub-Section(s) Field 
Incidents Incident > Investigation > Evidence Log Owner Name Person 
Incidents Incident > Investigation > Evidence Log Person In Possession 
Incidents Incident > Investigation > Evidence Log Secured/Storage Location 
Incidents Incident > Investigation > Evidence Log Seized By Person 
Incidents Incident > Investigation > Evidence Log Seized From Person 
Incidents Evidence Log > Status Disposition 
Incidents Evidence Log > Status Evidence/Property Tag 
Incidents Evidence Log > Status Reason for Status Change 
Incidents Evidence Log > Status Status Changed By Person 
Incidents Evidence Log > Status Storage Location 
Incidents IncidentInvestigationInterviewHistory ChangedByPersonDescription 
Incidents IncidentInvestigationInterviewHistory Reason 
Incidents Investigation > Interviews Incident ID 
Incidents Investigation > Interviews Location of Interview 
Incidents Investigation > Interviews Subject of Interview 
Incidents Investigation > Interviews Subject's Involvement Type 
Incidents Investigation > Interviews Witness 
Incidents Investigation > Interviews Word File 
Incidents Incident > Investigation > Log Expense Type 
Incidents Incident > Investigation > Log Incident ID 
Incidents Incident > Investigation > Log Log Notes 
Incidents Incident > Investigation > Log Task Done By Person 
Incidents Incident > Investigation > Log Task Type 
Incidents Incident > Investigation > Summaries Word File 
Incidents Incident > Investigation > Summaries Author 
Incidents Incident > Investigation > Summaries Incident 
Incidents Incident > Investigation > Summaries Plain Text 
Incidents Incident > Investigation > Summaries Summary Type 
Incidents IncidentInvestigationSummaryHistory ChangedByPersonDescription 
Incidents IncidentInvestigationSummaryHistory Reason 
Incidents Incident > Investigators Comments 
Incidents Incident > Investigators Incident ID 
Incidents Incident > Investigators Investigator 
Incidents Incident > Investigators Investigator Type 
Incidents Incident > Items Category/Type 
Incidents Incident > Items Disposition 
Incidents Incident > Items Item Name 
Incidents Incident > Items Item Value 
Incidents Incident > Items Linked Item 
Incidents Incident > Items Make/Model 
Incidents Incident > Items Notes 
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Section Sub-Section(s) Field 
Incidents Incident > Items Organization Owned By 
Incidents Incident > Items Person Owned By 
Incidents Incident > Items Serial Number 
Incidents IncidentNarrativeHistory PersonDescription 
Incidents IncidentNarrativeHistory Reason 
Incidents Incident > Narratives Author 
Incidents Incident > Narratives IncidentNumber 
Incidents Incident > Narratives Narrative 
Incidents Incident > Narratives Narrative Type 
Incidents Incident > Narratives Plain Text 
Incidents Incident > Organization > Requests  Request Assigned To Person 
Incidents Incident > Organization > Requests  Notes 
Incidents Incident > Organization > Requests  Tracking Number 
Incidents Incident > Organization > Requests  Request Type 
Incidents Incident > Organization > Responses Notified By Person 
Incidents Incident > Organization > Responses Responding Person 
Incidents Incident > Organization > Responses Response Notes 
Incidents Incident > Organizations Comments 
Incidents Incident > Organizations Contact First Name 
Incidents Incident > Organizations Contact Last Name 
Incidents Incident > Organizations Contact Middle Initial 
Incidents Incident > Organizations Contact Person 
Incidents Incident > Organizations Contact Phone 
Incidents Incident > Organizations Involvement Type 
Incidents Incident > Organizations Linked Organization 
Incidents Incident > Organizations Notified By 
Incidents Incident > Organizations Organization Name 
Incidents Incident > Organizations Organization Number 
Incidents Incident > Organizations Organization Type 
Incidents Incident > Organizations Organization Webpage URL 
Incidents Incident > Organizations Reference Number 
Incidents Incident > Owner > History  Comments 
Incidents Incident > Owner > History  Owner Person 
Incidents Incident > Owner > History  Owner Added Date 
Incidents Incident > Person > Clothing Clothing Type 
Incidents Incident > Person > Clothing Color 
Incidents Incident > Person > Clothing Description 
Incidents Incident > Person > Flags Severity Level 
Incidents Incident > Person > Injuries Description 
Incidents Incident > Person > Injuries Injury Cause 
Incidents Incident > Person > Injuries Severity 
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Section Sub-Section(s) Field 
Incidents Incident > Persons Designation(s) 
Incidents Incident > Persons Employee Number 
Incidents Incident > Persons Eye Color 
Incidents Incident > Persons First Name 
Incidents Incident > Persons Flag Notes 
Incidents Incident > Persons Gender 
Incidents Incident > Persons Hair Color 
Incidents Incident > Persons Initial 
Incidents Incident > Persons Involvement Type 
Incidents Incident > Persons Last Name 
Incidents Incident > Persons Linked Person 
Incidents Incident > Persons Marital Status 
Incidents Incident > Persons Notes 
Incidents Incident > Persons Reviewed By Person 
Incidents Incident > Persons Title 
Incidents Incident > Reviews Comments 
Incidents Incident > Reviews Reviewed By Person 
Incidents Incident > Reviews Review Type 
Incidents Incidents Access Level 
Incidents Incidents AttachmentCount 
Incidents Incidents Corrective Action Summary 
Incidents Incidents Disposition 
Incidents Incidents Division Reported To 
Incidents Incidents e-Incident Number 
Incidents Incidents File Number 
Incidents Incidents Flag Notes 
Incidents Incidents Follow-up Required 
Incidents Incidents Incident Duration 
Incidents Incidents Incident Number 
Incidents Incidents Investigation Comments 
Incidents Incidents Investigation Duration 
Incidents Incidents Police File Number 
Incidents Incidents Policy Affected 
Incidents Incidents Policy Name: 
Incidents Incidents Primary Cause 
Incidents Incidents Reported to Division 
Incidents Incidents Reported to Police 
Incidents Incidents Reported to Supervisor 
Incidents Incidents Secondary Cause 
Incidents Incidents Status 
Incidents Incidents Summary 
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Section Sub-Section(s) Field 
Incidents Incident > Vehicles Color 
Incidents Incident > Vehicles Comments 
Incidents Incident > Vehicles Disposition 
Incidents Incident > Vehicles Driver Identified 
Incidents Incident > Vehicles Incident ID 
Incidents Incident > Vehicles Involvement Type 
Incidents Incident > Vehicles License Plate 
Incidents Incident > Vehicles Linked Vehicle 
Incidents Incident > Vehicles Make/Model 
Incidents Incident > Vehicles Plate Registered In 
Incidents Incident > Vehicles Style 
Incidents Incident > Vehicles Vehicle Driver 
Incidents Incident > Vehicles VIN 
Incidents Incident > Vehicles Year 
Incidents Link > Incidents Link Type 
Incidents Link > Incidents Linked From Incident 
Incidents Link > Incidents Linked To Incident 
Incidents Link > Incidents Notes 
Incidents Link Incident To Case Case Number 
Incidents Link Incident To Case Link Incident To Case 
Incidents Link Incident To Case Link Type 
Incidents Link Incident To Case Notes 
Incidents Link Incident To Case > Detail Building 
Incidents Link Incident To Case > Detail Category 
Incidents Link Incident To Case > Detail Class 
Incidents Link Incident To Case > Detail Incident Status 
Incidents Link Incident To Case > Detail Link Incident To Case 
Incidents Link Incident To Case > Detail Link Type 
Incidents Link Incident To Case > Detail Site 
Incidents Link Incident To Case > Detail Summary 
Incidents Link Incident To Incident > Detail Building 
Incidents Link Incident To Incident > Detail Category 
Incidents Link Incident To Incident > Detail Class 
Incidents Link Incident To Incident > Detail Incident Status 
Incidents Link Incident To Incident > Detail Link Incident Number 
Incidents Link Incident To Incident > Detail Site 
Incidents Link Incident To Incident > Detail Summary 
Incidents Site Rollups Address 2 
Incidents Site Rollups Section 
Items Item > Class Rollups Item Category 
Items Item > Class Rollups Item Class Name 
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Section Sub-Section(s) Field 
Items Item > Class Rollups Item Class Rollup Name 
Items Item > Class Rollups Item Type 
Items Item > Class Rollups Level3 
Items Item > Class Rollups Level4 
Items Item > Class Rollups Rollup Level 
Items Item Make Model Rollups Item Make 
Items Item Make Model Rollups Item Make Model Name 
Items Item Make Model Rollups Item Make Model Rollup Name 
Items Item Make Model Rollups Item Model 
Items Item Make Model Rollups Level3 
Items Item Make Model Rollups Level4 
Items Item Make Model Rollups Rollup Level 
Items Items Access Level 
Items Items Item Class Rollup 
Items Items Item Make Model Rollup 
Items Items Item Name 
Items Items Notes 
Items Items Owner Identified 
Items Items Owner Name Organization 
Items Items Owner Name Person 
Items Items Serial Number 
Organizations Link Persons Linked To Person 
Organizations Link Persons Link Type 
Organizations Link Person To Organization Link Type 
Organizations Link Person To Organization Notes 
Organizations Link Person To Organization Organization 
Organizations Link Person To Organization Person 
Organizations Link Vehicles Notes 
Organizations Organization > Addresses Address 1 
Organizations Organization > Addresses Address 2 
Organizations Organization > Addresses Geographic Rollup 
Organizations Organization > Addresses Organization ID 
Organizations Organization > Addresses Type 
Organizations Organization > Addresses Zip/Postal Code 
Organizations Organization > Email Addresses Email Address 
Organizations Organization > Email Addresses Organization ID 
Organizations Organization > Email Addresses Type 
Organizations Organization > Phone Numbers Organization ID 
Organizations Organization > Phone Numbers Phone Number 
Organizations Organization > Phone Numbers Type 
Organizations Organizations Access Level 
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Section Sub-Section(s) Field 
Organizations Organizations  Notes 
Organizations Organizations Organization Name 
Organizations Organizations Organization Number 
Organizations Organizations Organization Type 
Organizations Organizations Organization Webpage URL 
Organizations Organizational Rollups Org Level 1 
Organizations Organizational Rollups Org Level 2 
Organizations Organizational Rollups Org Level 3 
Organizations Organizational Rollups Org Level 4 
Organizations Organizational Rollups Org Rollup Name 
Persons Link Organizations Link Type 
Persons Link Organizations Linked From Organization 
Persons Link Organizations Linked To Organization 
Persons Link Vehicles Link Type 
Persons Link Vehicles Linked From Vehicle 
Persons Link Vehicles Linked To Vehicle 
Persons Person > Addresses Address 1 
Persons Person > Addresses Address 2 
Persons Person > Addresses Address Type 
Persons Person > Addresses Geographic Rollup 
Persons Person > Addresses Zip/Postal Code 
Persons Person > Email Addresses Email Address 
Persons Person > Email Addresses Email Type 
Persons Unique Features Description 
Persons Unique Features Feature Type 
Persons Unique Features Location 
Persons Person > Flag List Flag Description 
Persons Person > Flag List Letter Code 
Persons Person > Flags Severity 
Persons Identification Comments 
Persons Identification Identification Number 
Persons Identification Identification Type 
Persons Identification Issued By 
Persons Person > Phone Number Phone Number 
Persons Person > Phone Number Phone Type 
Persons Persons Access Level 
Persons Persons Additional Information 
Persons Persons Designation 
Persons Persons Employee 
Persons Persons Employee Number 
Persons Persons Eye Color 
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Section Sub-Section(s) Field 
Persons Persons First Name 
Persons Persons Flag Notes 
Persons Persons Gender 
Persons Persons Hair Color 
Persons Persons Initial 
Persons Persons Last Name 
Persons Persons Title 
Persons Person > Trespasses Comments 
Persons Person > Trespasses Site Rollup 
Vehicles Link > Organizations Notes 
Vehicles Link Organization To Vehicle Link Type 
Vehicles Link Organization To Vehicle Notes 
Vehicles Link Organization To Vehicle Organization 
Vehicles Link Organization To Vehicle Vehicle 
Vehicles Link Persons Linked From Person 
Vehicles Link Persons Notes 
Vehicles Link Person To Vehicle Link Type 
Vehicles Link Person To Vehicle Notes 
Vehicles Link Person To Vehicle  Person 
Vehicles Link Person To Vehicle Vehicle 
Vehicles Vehicle > Make Model Rollups Make 
Vehicles Vehicle > Make Model Rollups Model 
Vehicles Vehicle > Make Model Rollups Rollup Level 
Vehicles Vehicle > Make Model Rollups Rollup Name 
Vehicles Vehicle > Make Model Rollups Vehicle Make Model Name 
Vehicles Vehicle > Make Model Rollups Vehicle Make Model Rollups 
Vehicles Vehicles Access Level 
Vehicles Vehicles Branch 
Vehicles Vehicles Color 
Vehicles Vehicles Comments 
Vehicles Vehicles Company Vehicle 
Vehicles Vehicles Division 
Vehicles Vehicles Geographic Rollup 
Vehicles Vehicles License Plate 
Vehicles Vehicles Photo 
Vehicles Vehicles Style 
Vehicles Vehicles Vehicle Make/Model 
Vehicles Vehicles Vehicle Value 
Vehicles Vehicles VIN 
Vehicles Vehicles Year 

 


